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What is MergeFax?





MergeFax 1.0 is an add-on program that allows you to mail-merge group fax hundreds of PERSONALIZED faxes with Word for Windows 6.0 and WinFax PRO 3.0 (and WinFax PRO for Networks)—all with one simple keystroke.





MergeFax is one of those rare programs that will save you and your employees hours of time. Plus, the date and time scheduling features alone will save you big bucks by allowing you to schedule your faxes late at night when the rates are dirt cheap.





Before the creation of MergeFax, the best you could do was "group fax" the same document to everyone. Ex: "Dear Customer, thank you for your interest in Ski Chalet products."





The power of MergeFax is that it allows you to use Word for Windows 6.0's awesome mail-merge features to group fax PERSONALIZED faxes to each individual. Ex: "Dear Jim, thank you for your interest in our winter ski product line." "Dear Joe, thank you for your interest in our arrow ski downhill racers." Etc.





MergeFax-ing is as simple as these 2 steps:


1. Set up your mail-merge main document.


2. Hit Alt-M and START.





Here’s how it works:





MergeFax automatically merges each data record, scans the document to find the recipient’s name and fax number, and then (using DDE) passes this information over to WinFax PRO.





MergeFax queues up all the faxes in WinFax PRO's event list—either to be sent immediately or scheduled for a later date and time.





MergeFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to fiddle with driver settings. You just hit Alt-M and Start, and MergeFax takes care of everything else.





MergeFax does all this in minutes! On a 486-66 machine, MergeFax queues up WinFax PRO's event list with 100 faxes in 5 minutes!








Installation and Setup





To setup MergeFax, DOUBLE CLICK the "install button." The MergeFax Setup dialog box will appear.





� MACROBUTTON MergeFaxInstall ��





Note: This setup is made to be run again and again, anytime you wish to choose different default settings or re-design your own custom identifiers.





Note: For MergeFax to install properly, all three files (MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP) must be in the same directory (for example C:\MERGEFAX). This is because the install macro looks for MERGEFAX.DOT and MERGEFAX.BMP in the same directory that you open MERGEFAX.DOC.





We recommend you create a directory called C:\MERGEFAX to store all the MergeFax files. This way you can re-run the Install MergeFax macro any time in the future should you decide to change any of the defaults or re-design your own custom identifiers.





This is what the install program does:


It copies the MergeFax macro into your NORMAL.DOT template so that it will be available globally.


It assigns the keyboard shortcut key of Alt-M to the MergeFax macro.


It adds MergeFax to the menu of your choice.








MergeFax Identifiers: “To:” & “Fax:” or Whatever you want!





MergeFax searches for “To:” and “Fax:” (or any custom identifiers you create) to identify the recipient’s name and fax number.





MergeFax allows you to create any custom identifiers you wish! For example, if you prefer “Fax #:”, or “Fax No.:”, or “Fax Number:”, etc., simply re-run the setup program above to make the identifiers anything you want.





Because MergeFax scans the entire document, the “To:” and “Fax:” information can be anywhere in your fax. Normally, they will be on the fax cover page, or if you are faxing a one page letter, they will be on that. But the nice thing about MergeFax is that they don’t have to be. They can be anywhere. And in any order.





For example, they can be on the same line, like this:





				To: Woody Allen Fax: 555-555-5555





Or they can be reversed, like this:





				Fax: 555-555-5555 To: Woody Allen





Or they can be separated by tabs, like this:





				To: 				Woody Allen


				Fax:			555-555-5555





Or they can have leading text on the same line, like this:





				This message To: Woody Allen





Or they can have following text on the same line (as long as there is a tab or at least two spaces after the name or fax number), like this:





				To: Woody Allen  Date: June 20, 1995





In fact, MergeFax's search routines are so smart, it will even work with everything crammed together on one line, like this:





				To:Woody AllenFax:555-555-5555





Note: MergeFax always goes to the top of the document and searches down. So, if there is more than one identical identifier in a document, it will always find the first one.








The Big Tip: "Hidden Identifiers"





MergeFax's ability to find "hidden identifiers" gives you complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing MergeFax to find the recipient's name and fax number accurately. To understand how this works, please see the following 3 examples:





Example 1: Hiding the "To:" and/or "Fax:"





If you don't want the “To:” or “Fax:” to show up on your fax, you can make them “hidden identifiers” by selecting them and choosing Format>Font>Hidden text. MergeFax will still find the name and fax number, but the hidden “To:” or “Fax:” won’t show up on your fax.





For example, you might want to fax a one page letter containing the recipient’s name, address, and fax number—but in this case, you wouldn’t want the word “To:” to show up. Simply do it like this:





To: Jay Bonzi


396 17th St.


Paso Robles, CA  93446


Fax: 805-238-5798





Dear Jay,





I love MergeFax! Great work! Kudos!





(Note: there is a hidden “To:” before the name Jay Bonzi. If you cannot see this, hit Tools>Options>View>Nonprinting Characters>Hidden Text. Once you see it, and know it’s there, go ahead and hit File>Print Preview to see that it doesn’t show up when you print and/or fax.)





Example 2: Using Separate Cells





If you split “To:” and "Woody Allen" into separate cells, MergeFax has no way of knowing they are related.





To:�
Woody Allen�
�



But not to worry! If you prefer this two-cell method, you can easily make it work with hidden identifiers! Simply custom design a name identifier (into anything different than "To:". For example, I use "To>"). Then simply add that "To>" as a hidden identifier. Like this:





To:�
To> Woody Allen�
�



MergeFax will search for "To>" and find Woody Allen! (Notice, too, that my hidden identifier "To>" is in a tiny 8 point font so that it is nearly unnoticeable on the screen.)





Example 3: Skipping over YOUR fax number





If you have a header with YOUR fax number in it, you will want MergeFax to skip over your fax number and find the recipient’s fax number. You could simply make your fax number identifier anything different—like “Fax” or “(Fax)” or “Fax #”, etc. Or, if you want to use the same identifier for both your fax number and the recipient’s fax number, you can simply use a hidden identifier (like "Fax>"). Example:





ABC Widget Co.


1225 Main St., Paso Robles, CA  93446


Phone: (805) 222-2222  Fax: (805) 444-4444





To: So-and-so.


Fax:  Fax> 555-555-5555





Dear So-and-so,





I love your widgets! Great work! Kudos!





Or, another way is to simply add a hidden space between "Fax" and the ":" in your letterhead. MergeFax will then skip over your fax number and find the recipient's fax number because it is looking for "Fax:" not "Fax(space):". On the screen, your fax number identifier will look like this: "Fax:". But that hidden space won't print, so on the fax, it will look like this: "Fax:".





So you see, with MergeFax 1.0, you have complete flexibility in designing your faxes to look exactly the way you want, while at the same time allowing MergeFax to find the recipient's name and fax number accurately.








Date and Time Scheduling





MergeFax allows you to send your group fax immediately or shedule them for a later date and time.





When  you choose "Now" (the default), MergeFax queues up all the faxes in WinFax PRO's event list. After the last fax is queued up and ready to go, WinFax begins sending them off.





When you choose "Scheduled", you can set the faxes for any future date and time. This is especially useful for taking advantage of the cheaper phone rates late at night.





When you schedule, remember that WinFax PRO only accepts date and time in the following formats: Date: MM/DD/YY. Time: HH:MM:SS. This is not hard to remember, as MergeFax displays the correct formats for you in the date and time fields. Notice, too, that MergeFax always defaults to today's date so that you can easily schedule faxes for later that day, or simply change one number to shedule them for the following day.








Checking to make sure data is merging correctly





There are two ways to check and confirm that your data is merging correctly.





The first is before you run MergeFax. With the "view merged data" button on, you can click the "next record" button to jump from record to record and see how each record is merging with your mail-merge document. You'll know immediately if there are any changes you need to make to your data source before running MergeFax. (Or, you could also merge to a temporary document and browse it).





The second way is after you run MergeFax. With all the faxes scheduled and queued up in the WinFax event list, you can view and peruse the graphical fax pages to make sure they were merged properly. What you see at this point is exactly what will be sent, so you can be confident in the knowledge that everything merged perfectly.





Note: MergeFax does not work with WinFax PRO's "Preview/Annotate" feature turned on. We recommend you turn off Preview/Annotate before running MergeFax.





Using hidden prefixes and suffixes





Just as hidden text works nicely for hidden identifiers, the same principle can be applied to numbers, or even text, that you need to pass to WinFax PRO, but that you don't want to show up on the fax.





For example, to dial the prefix "9" (to get an outside line) before every phone number, simply enter it as hidden text on your mail-merge main document. Example:





 		Fax: 9,,805-238-5798





You won't see it on the fax, but MergeFax will find it, enter it in the fax number field, and pass it over to WinFax PRO for dialing. (Note: You can even include comma delays if needed.) If you require prefixes like this, simply add it as hidden text to your main mail-merge document before the fax number field like this:





		 Fax: 9,,<<Fax Number>>





Note: MergeFax uses DDE (dynamic data exchange) to pass the fax numbers over to WinFax PRO. DDE bypasses WinFax's prefix settings and passes the numbers directly to the modem for dialing. Because of this, your fax numbers will have to contain all the numbers required for dialing—including long distance codes, etc. We recommend you go through your data one time to add or remove any necessary numbers.





Or you could use the hidden prefix technique above for faxing long distance and international numbers. To do this, query out the long distance numbers and send them as a batch. Then query out the international numbers and send them as a batch, etc.





The next version of MergeFax will most likely contain prefix and suffix features to make up for DDE's lack of prefix and suffix support. But for right now, MergeFax simply passes whatever data you give it to WinFax PRO. So you must enter your data exactly as WinFax will need it for dialing.








Suggestions





Read chapter 29 ("Mail Merge: Step by Step") in Word 6.0 User's Guide





If you already know how to mail merge, there is nothing more for you to learn to run MergeFax because MergeFax simply takes advantage of Word for Windows 6.0's awesome mail-merge features.





If you don't know how to mail merge, you'll need to learn how to set up a mail merge main document and attach a data source to it, etc. All this information is explained clearly in chapter 29 of the Word for Windows 6.0 User's Guide. Don't be intimidated. Word for Windows 6.0 has the simplest mail merge setup we've ever seen. You'll be up and rolling in no time.





Assigning MergeFax to a toolbar button





If you’re a toolbar person, assign MergeFax to a toolbar button. The only reason we didn’t automatically install it on your toolbar is because monitors that run 640x480 don’t have any more room to add toolbar buttons.





Upgrade from WinFax Lite to WinFax PRO 3.0 (or WinFax PRO for Networks)





MergeFax does not work with Delrina's WinFax Lite because WinFax Lite does not support DDE like WinFax PRO 3.0 (and WinFax PRO for Networks) does. Therefore, with WinFax Lite, MergeFax has nothing to "pass" the information to. If Delrina ever upgrades WinFax Lite to include DDE support, then MergeFax should work with it also. But until they do, only WinFax PRO 3.0 users can take advantage of MergeFax's dynamic data exchange.








Registration





MergeFax 1.0 is shareware. Unregistered evaluation copies can be distributed freely. However, licensed copies belong only to registered users who have purchased a permanent license. The price for a permanent license is $55.





To register MergeFax, send a check or money order (payable to: Jay Bonzi) for the total number of copies you wish to register to:





				BONZI SoftWare


				396 17th Street


				Paso Robles, CA  93446





Or you can register quickly by Fax or E-mail, with a charge card (Visa, MasterCard, or Discover). Simply include the name as it appears on the card, type of card (Visa, MasterCard, or Discover), the card number, and expiration date. Send to either:





				Fax: (805) 238-5798


				CompuServe: 72053,2227





When you register, I will send you a personal registration number that will end the trial period and turn your evaluation copy into a licensed version. So even if you register by mail, you may want to include your fax number or e-mail address to more quickly receive your registration number.





Also, when you register, I will enter you into our database of registered users, so that we can notify you immediately of future versions and updates.








FAstFax 3.0





Also, let us know if our other product FAstFax 3.0 sounds like something you might be interested in. FAstFax makes sending single faxes with Microsoft Word for Windows 6.0 and Delrina WinFax PRO 3.0 (and WinFax PRO for Networks) lightning fast by cutting 17+ keystrokes down to 2.





Here’s how:





FAstFax searches your document, finds the recipient’s name and fax number, and (using DDE) automatically passes this information over to WinFax PRO—so you no longer have to keep TWO separate phonebooks. If you’re tired of typing a person’s name and fax number TWICE—once on the document and again in the WinFax Phonebook—you will love FAstFax.





FAstFax gives you a thumbnail page preview of your document—so you’ll always fax the correct pages and be able to check the final look and layout of your fax before letting that puppy fly.





FAstFax allows you to easily fax an entire document or just the current page—which is great for those quick 1 page faxes.





FAstFax automatically sets the fax driver and resets the printer driver for you—so you don’t have to think about driver settings again. And no more print jobs accidentally sent to the fax modem!





FAstFax does all this in 2 keystrokes!





The greatest benefit of FAstFax 3.0 is this: once you've entered a person's contact information into your database ONE TIME, you will never have to type it again. You can now keep all of your names and fax numbers in a PIM, Contact Manager, or even the Word 6.0 database—and once entered, you will never have to re-type a person's name and fax number again, either in the WinFax phonebook, or on the fax itself. (Even PIMs and Contact Manager software that integrate with the WinFax Phonebook cannot give you this functionality because you'll still find yourself having to type the person's name and fax number on every fax.)








If you have any questions...





If you have any questions at all, feel free to fax me at 805-238-5798 any time, day or night. (Note: That's my home computer. And I work from 9:30am - 5:30pm Pacific time, so I’ll be able to fax you back that evening, or early the next morning. No matter what, I promise I’ll get back to you within 24 hrs.)





Or you can E-mail me on CompuServe at 72053,2227. I check my E-mailbox frequently, and if you're having problems, I'll get right back to you!








* * * * * * * * * * End of MergeFax User’s Guide * * * * * * * * * *





�






* * * * * License Agreement * * * * *





You are encouraged to use this program for 3 sessions prior to obtaining a permanent license. You may share the files MERGEFAX.DOC, MERGEFAX.DOT, and MERGEFAX.BMP with anyone you choose as long as you do not change them. You may not share the registration key, which is supplied to licensed users only. If you choose to continue using the program and register, that registration key may be used only by the licensee specified in the original order for the license. Licenses are not transferable and may not be modified. A single License permits you to use one copy of the MergeFax software on any single computer, provided the MergeFax software is in use on only one computer at any time. If you have multiple Licenses for MergeFax, then at any time you may have as many copies of MergeFax in use as you have Licenses.





It is your responsibility to determine if the program will work reliably on your equipment and for your particular business environment. BONZI SOFTWARE DISCLAIMS ALL WARRANTIES RELATING TO THIS SOFTWARE, WHETHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, AND ALL SUCH WARRANTIES ARE EXPRESSLY AND SPECIFICALLY DISCLAIMED. NEITHER BONZI SOFTWARE NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY INDIRECT, CONSEQUENTIAL, OR INCIDENTAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE SUCH SOFTWARE EVEN IF BONZI SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR CLAIMS. IN NO EVENT SHALL BONZI SOFTWARE'S LIABILITY FOR ANY DAMAGES EVER EXCEED THE PRICE PAID FOR THE LICENSE TO USE THE SOFTWARE, REGARDLESS OF THE FORM OF CLAIM. THE PERSON USING THE SOFTWARE BEARS ALL RISKS AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE. Some states do not allow the exclusion of the limit of liability for consequential or incidental damages, so the above limitation may not apply to you.





This agreement shall be governed by the laws of the State of California and shall inure to the benefit of BONZI SoftWare and any successors, administrators, heirs and assigns. Any action or proceeding brought by either party against the other arising out of or related to this agreement shall be brought only in a STATE or FEDERAL COURT of competent jurisdiction located in San Luis Obispo County, California. The parties hereby consent to in personam jurisdiction of said courts.








* * * * * Acknowlegements - Trademarks * * * * *





WORD FOR WINDOWS and Microsoft are registered trademarks of Microsoft Corporation.





WINFAX PRO and Delrina are trademarks of Delrina Technology Inc.





MERGEFAX and FASTFAX are trademarks of BONZI SoftWare.





